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Keyboard Shortcuts

General
App List Tile Group App Tile Start menu ............ccoooee....... a
|
Copy a file or folder.............. Ctrl+C
Cut afile or folder ................ Ctrl + X
Paste a file or folder ............. Ctrl +V
Action Center ..................... A
Task VIEW .....coovviiiiiiieiiiins & + Tab
Close an app.... Alt + F4
Lock computer L
Print ..o Ctrl + P
|_Start . o~
Menu File Explorer ........cccovveeeenn. ar +E
Account Run dialog boX............cc...... & R
Documents —gis RN Ease of Access Center......... & v
Pictures Task Manager ..................... Ctrl + Shift
Settings I‘E.sc
Power RS Capture screenshot.............. a7 + PrtScn
- Show Ay
ere to searc — R a +
O] o e nere tosearcn Desktop Open Searc .: S
Open Narrator..................... ax + Enter
Start Search Task Pinned Taskbar System
Button Field View Apps Icons Settings Shortcuts

Start Menu

Open the Start Menu: Click the Start #® button on
the taskbar, or, press the 4¥ key.

Resize an App Tile in the Start Menu: Right-click a
tile, select Resize, and select a size.

Rearrange Tiles: Click and drag a tile to a new
location in a group. Or, drag a tile between groups
to start a new group.

Remove a Tile from the Start Menu: Right-click a
tile and select Unpin from Start.

Add a Tile to the Start Menu: Right-click an app
and select Pin to Start.

Turn off an App's Live Tile: Right-click a tile, select
More, and select Turn Live Tile off.

Rename Tile Groups: Click a tile group’s name,
type a new name, and click outside the name field
to save the changes.

LLock Your Computer: Click the Account ®putton
and select Lock.

Sign Out of Windows: Click the Account @button
and select Sign Out.

Shut Down or Restart Your PC: Click the Power
® button and select either Shut down or
Restart.

Apps & Taskbar

LLaunch an App: Click the app’s tile in the Start
menu. Or, scroll through the list of apps at the left
of the Start menu and select the app you want to
open.

Install an App: Click the Microsoft Store icon on
the taskbar. Browse or search for the app you
want and click it. Click Get to install a free app or
Buy to install a paid app.

Update an App: Click the Microsoft Store icon
on the taskbar and click the See more.. .. button
at the top-right of the window. Select Downloads
and updates and click the Get updates button
at the top of the window.

Uninstall an App: Click the Start & button and
click the Settings % button at the left of the Start
menu. Click the Apps category and select Apps
& features at the left. Select the app you want to
remove and click the Uninstall button.

Hide the Taskbar: Right-click an empty space on
the taskbar, choose Taskbar settings, then
toggle Automatically hide the taskbar in
desktop mode.

Windows 10 Tablet Mode: Swipe in from the right
side of the screen and click the Tablet Mode
button.

Windows settings................. A
Connect Pane.........c.coou...... &K
Sharingpane.........cccccooenee. 2 +H
Display options for
second SCreen.................... P
Quick Link menu.................. a8+ X
Show/hide desktop .............. & +D
Maximize window &1
Minimize/Restore window..... s+ J
Minimize all windows............ &M
Snap window to left.............. a8 <«
Snap window to right ........... RN
View open apps........c.c........ Ctrl + Alt +
Tab
Switch between apps........... Alt + Tab
New desktop .........ccccvveeennn. a2 Ctrl + D
Switch desktops .................. &+ ctrl+
el
Close active desktop............ A2 + Ctrl + F4
Peek at desktop................... s s
Minimize all but the
active window...................... 22 + Home
Refresh active window ......... F5
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New Features

The Action Center: Gathers recent
notifications. Click the Action Center L]
button on the taskbar or slide your finger in
from the right side of the screen on a
touchscreen device to view it. It also includes
some helpful quick commands:

3 @A & Ld

Tablet mode  Network

Al settings

Jia % op

Airplane mode

Location Not connected
S k-

Night light

Edge: Microsoft’s faster, more secure web
browser. While Internet Explorer is still
available in Windows 10, Edge is the preferred
browser. Click the Edge € icon on the taskbar
to start browsing.

Task View: Allows you to add and switch
between multiple desktops. Click the Task
View St button on the taskbar, then click the
New Desktop + button for each additional
desktop you'd like to add. Click a desktop’s
thumbnail in Task view to switch to it.

Deskiop 1 Desktop 2 New desktop

LIS

Tablet Mode: A mode in Windows, optimized
for touch, that automatically engages when a
touchscreen device or hybrid computer is in
use. Manually turn Tablet mode on or off in the
Action Center.

The Settings App: An application that includes
a number of options to control how your
Windows 10 operating system behaves. Click
the Start ¥ button, then click the Settings i1
icon to open and modify the system settings.

Quick Access: A customizable view in File
Explorer that includes a few pinned folders, as
well as some other folders and files that you've
used the most. Click the File Explorer = icon
on the taskbar to see the Quick Access
screen.

Windows Ink: Used for touch screen devices
with a stylus, Windows Ink allows you to write
on your screen or create sticky notes and
drawings. Click the Windows Ink Workspace
% icon on the taskbar to enable drawing with a
stylus.

Windows Hello: A secure sign in feature that
allows you to sign into Windows 10 using facial
recognition or a fingerprint. Click the Start =&
button and click the Settings i11icon. Then
click Accounts and select Sign-in options at
the left. Under Windows Hello, select Set up.
Note: Windows Hello is not available for use
on every device.

Folders and Files

Open File Explorer: Click the File Explorer =
icon on the taskbar. Double-click a file or folder
to open it.

The File Explorer Ribbon: Contains options
you'll need to work with your files. Click a
ribbon tab (i.e. Home, Share, View) to see
related commands.

+ B QF ¢ [F X =f
s Copy path
Pinto Quick Copy FPaste Move Copy Delete Rename  New
[ rostesnonae | "o SO Dl e,

Share  View

) New item =

] Easy access »

Clipboard Organize New

Move or Copy Files and Folders: Select the file
or folder you want to move, then click the
Home tab on the ribbon. Click the Move To «
or the Copy To ' button and select the
destination folder.

Rename Files and Folders: Select the file or
folder you want to rename in File Explorer and
click the Home tab on the ribbon. Click
Rename =I in the Organize group. Type a new
name for the file or folder, then press Enter.

Delete Files or Folders: Select a file or folder to
delete in File Explorer. Click the Home tab on
the ribbon and click the Delete * button list
arrow. Select Recycle to move it to the recycle
bin or Permanently Delete to completely
remove the file or folder from your computer.

Search File Explorer: Click in the Search field
in the upper-right corner of the File Explorer
window. Type your search term(s). Use the
options in the Location group of the Search tab
to change the search location.

File Explorer Views: Click the View tab in the
File Explorer window. Use the options here to
change how your files are viewed and
organized.

Compress Files or Folders: Select the files or
folders you want to compress and click the
Share tab on the ribbon. Click the Zip 'i
button and type a name for the compressed
folder, then press Enter.

Create a Desktop Shortcut: Right-click a file,
folder, or program, then select Send To.
Select Desktop (Create Shortcut) in the
menu.

Sort Desktop lcons: Right-click the desktop
and select Sort by in the menu. Select a sort
option.

Change the Desktop Background: Click the
Start &8 button and click the Settings & icon.
Click Personalization and then use the
options in the Background category to select a
new background color or image.

Pin a Program to the Taskbar: With the
program running, right-click its icon on the
taskbar and select Pin to taskbar.

Personalize Windows

Personalize Windows

Customize System |cons: Click the Start &a
button and click the Settings & icon. Click
Personalization and then click Taskbar at the
left. If needed, scroll down and click Turn
system icons on or off. Toggle a system icon
on or off.

Move the Taskbar: Right-click the taskbar, if
Lock the taskbar has a check mark next to it,
click it to unlock the taskbar. Click and drag the
taskbar to the top, bottom, or side of the
screen.

Customize the Lock Screen: Click the Start im
button and click the Settings & icon. Click
Personalization and then click Lock screen
at the left. Here, select the desired
background, app status icons, and settings.

Customize Account Settings: Click the Start am
button and click the Settings & icon. Click
Accounts and then click Sign-in options at
the left. Modify your account settings here.

Maintain Your Computer

Check for Windows Updates: Click the Start i@
button and click the Settings % icon. Click
Update & Security and then click the Check
for updates button.

Open the Task Manager: Right-click the Start
&% button and select Task Manager. Or, press
Ctrl + Shift + Esc. If an open task is no longer
responding, select it here and click the End
task button.

Improve Battery Life: Click the Battery status
= jcon in the system tray and click Battery
settings. Adjust the settings here to improve
the battery life of your computer.

Secure Windows: Click the Security Center
& icon in the system tray. A few options for
ensuring Windows is secure include:

e Virus & threat protection periodically
checks your computer for viruses and
other malicious files.

e Account protection provides security for
your account and sign-in.

o Firewall & network protection
configures network firewalls for private and
public networks to keep your computer
safe from network attacks.

e App & browser control is where you
configure warnings for suspicious files,
applications, and websites that you
download and visit.

o Device performance & health keeps
track of system, software, and driver
updates, while monitoring storage space
and battery life.

o Family options lets you set up parental
controls for this computer, as well as
connected devices.

¥

63 Click the topic links for free lessons!

© 2024 CustomGuide, Inc.
Contact Us: sales@customguide.com



https://ref.customguide.com/?utm_source=qr&utm_medium=pdf&utm_campaign=qr-ref
mailto:sales@customguide.com
https://www.customguide.com/windows-10/notifications-pane-and-action-center?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/notifications-pane-and-action-center?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/microsoft-edge?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/microsoft-edge?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/use-multiple-desktops?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/use-multiple-desktops?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/tablet-mode?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/the-settings-app?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/the-settings-app?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/quick-access?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/quick-access?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/windows-ink?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/windows-ink?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/windows-hello?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/windows-hello?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/file-explorer?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/file-explorer?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/file-explorer?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10#the-ribbon
https://www.customguide.com/windows-10/organize-folders-and-files?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/organize-folders-and-files?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/organize-folders-and-files?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10#rename-folders-and-files
https://www.customguide.com/windows-10/organize-folders-and-files?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10#rename-folders-and-files
https://www.customguide.com/windows-10/recycle-bin?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/recycle-bin?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/find-files?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/file-explorer-views?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/compressed-folders?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/compressed-folders?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/desktop-icons-and-shortcuts?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/desktop-icons-and-shortcuts?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10#sort-your-desktop
https://www.customguide.com/windows-10/backgrounds-and-colors?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/backgrounds-and-colors?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/customize-the-taskbar?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/customize-the-taskbar?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10#customize-system-icons
https://www.customguide.com/windows-10/customize-the-taskbar?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10#customize-system-icons
https://www.customguide.com/windows-10/move-and-resize-the-taskbar?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/personalize-the-lock-screen?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/personalize-the-lock-screen?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/user-accounts?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/user-accounts?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/windows-update?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/windows-update?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/task-manager?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/task-manager?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/improve-battery-life?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/improve-battery-life?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/make-windows-secure?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10
https://www.customguide.com/windows-10/make-windows-secure?utm_source=qr&utm_medium=pdf&utm_campaign=qr-topics&utm_term=windows-10

Custom

www.customguide.com

Customizable Courses
3,000 bite-sized skills, ready for use o
personalization. SCORM-compatible.

Skill Assessments
Pinpoint existing knowledge, spot
deficiencies and measure improvemen

Al Course Builder
Create stunning courses with
Al-enhanced content. Similar to
Articulate Rise—but better!

LMS
A friendly, versatile learning platform
your users will love.

Microsoft Training
Bite-sized Skills. Ready to Use. Uniquely Yours.

D & O @

r

Access Business Excel Microsoft
Skills 365
t. @
OneDrive OneNote Outlook PowerPoint
SharePoint Teams Windows Word

Microsoft Training From Experts, For Experts

Are You:

Needing to boost Office proficiency quickly?

Seeking training tailored to your organization’s unique

IT needs?

Overwhelmed by constant Office updates?

Master Skills,
Not Just Courses

Motivate learners by showcasing
their journey from novice to expert
with evident learning outcomes.

Our customizable courses &
skill assessments:

1. Evaluate over 3,000 job skills
2. Verify learning
3. Measure improvement

CustomGuide:

Our interactive courses simulate the experience of
using real software!

Customize our courses to align perfectly with your
organizational workflows and requirements.

Our courses stay current with Office updates,
ensuring you're always ahead.

SKILLS LESSON |POST-ASSESS GRQW
"\

(D) Microsoft Teams o, 175 (000 cn
Join & Create Teams ® Fail ® Complete @® Pass

Use Team Channels ® Pass ® Complete ® (Pass)

Manage Shared Files ® Fail ® Complete ® Pass

Manage Team Membership ® Fail ® Complete @ Fail

BeSovre Tvaining AStevr Tvaining

Trusted by 3,000 Organizations

amazon

“Customizing the courses
has saved countless hours
of work.”

@ www.customguide.com

* * G * * G G
* * * * H Enterprise
ngh Easiest To Do High
Performer Business With Performer
O FALL
2023 2023 FALL
“Everyone is impressed with your
features and ease of use. What a *****
I” 4.8 outof 5

terrific product

Contact Us

For a Free Trial! b info@customguide.com


https://www.customguide.com/?utm_source=qr&utm_medium=pdf&utm_campaign=qr-page3
https://www.customguide.com/?utm_source=qr&utm_medium=pdf&utm_campaign=qr-page3
https://www.customguide.com/?utm_source=qr&utm_medium=pdf&utm_campaign=qr-page3



